MANUAL DE USUARIO
Como veremos en los siguientes apartados, el usuario del sistema podrá crear grafos prediseñados (apartado 1), editar grafos (apartado 2), establecer pesos para nuevas aristas (apartado 3), guardar, cerrar y abrir grafos (apartados 4, 5 y 6, respectivamente) y aplicar algoritmos sobre árboles generadores a grafos creados previamente (apartado 7).

Al arrancar el sistema, se muestra la ventana principal del mismo. Esta ventana contiene una barra de menús y, debajo, el área de dibujo de grafos.
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Ventana principal
Distinguiremos dos modos de funcionamiento del sistema:

· Modo de edición, en el que se podrá editar el grafo que se esté representando en el área de dibujo. Al arrancar el sistema, éste empezará a funcionar en este modo.

· Modo de aplicación de un algoritmo, en el que se podrá aplicar un algoritmo sobre árboles generadores al grafo representando en el área de dibujo.

Más adelante iremos viendo que ciertas operaciones sólo se pueden realizar en el modo de edición (entre ellas, por supuesto, editar un grafo). Veremos a continuación cómo saber si el sistema está funcionando en un modo u otro y cómo volver al modo de edición cuando el sistema está funcionando en el modo de aplicación de un algoritmo.

Si en la ventana principal se muestra un panel de opciones, en el que se ofrecen opciones específicas para la aplicación de un algoritmo, el sistema está funcionando en el modo de aplicación de un algoritmo. En este modo de funcionamiento, el panel de opciones se sitúa debajo de la barra de menús y ocupa una parte del espacio de la ventana principal que, mientras el sistema está funcionando en el modo de edición, es ocupada por el área de dibujo.
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Panel de opciones
Si, por el contrario, en la ventana principal no se muestra el panel de opciones, el sistema está funcionando en modo edición.

¿Cómo se puede volver al modo de edición cuando se está aplicando un algoritmo? Basta con pulsar un botón que estará disponible en el panel de opciones en cualquier momento de la aplicación del algoritmo: el botón Back to graph edition.

En cualquier momento (y sea cual sea el modo en el que esté funcionando el sistema), el usuario podrá salir del sistema eligiendo la opción File → Exit.
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Salir del sistema
1. Crear un grafo prediseñado
Al arrancar el sistema, el usuario ya puede ir construyendo un grafo de forma manual, mediante operaciones de edición de grafos (que veremos en el apartado 2), pero también puede crear un grafo prediseñado de forma automática.

Cuando el sistema está funcionando en modo edición, se puede crear un grafo prediseñado siguiendo estos pasos:

1. Elegir la opción Edit → Create predesigned graph.
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Crear grafo prediseñado (1)
Al elegir dicha opción, se mostrará la siguiente ventana:
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Crear grafo prediseñado (2)
2. Hacer clic en el grafo que se desee crear (utilizar la barra de desplazamiento para ver todos los grafos disponibles). Se mostrará el grafo elegido en el área de dibujo (la siguiente figura corresponde al caso de que se elija el grafo de Petersen).
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Crear grafo prediseñado (3)
El grafo creado se puede editar si así se desea.

2. Editar un grafo
En el área de dibujo se pueden realizar distintas operaciones de edición de grafos, siempre que el sistema esté funcionando en modo edición.

2.1. Pintar un vértice

Se puede pintar un vértice haciendo clic sobre vacío.

2.2. Mover un vértice

Se puede mover un vértice arrastrándolo con el ratón (pulsando sobre el vértice con un botón del ratón y moviendo el ratón manteniendo el botón pulsado).

Las aristas incidentes con un vértice antes de mover éste seguirán siendo incidentes con el mismo después de moverlo. En la siguiente figura se muestra un grafo antes y después de mover uno de sus vértices:
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Mover un vértice
2.3. Pintar una arista

Se puede pintar una arista siguiendo estos pasos:

1. Seleccionar un vértice (para ello hay que hacer clic en el vértice). En la siguiente figura se muestra un grafo en el que se ha seleccionado uno de sus vértices:
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Pintar una arista (1)
2. Hacer clic en otro vértice tal que no exista ya una arista que una el vértice en cuestión y el vértice seleccionado; en caso de que ya exista la arista, se mostrará un mensaje de error (no se permiten aristas múltiples).
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Pintar una arista (2)
2.4. Cambiar el peso de una arista

A una nueva arista se le asigna automáticamente un peso, pero ese peso se puede cambiar siguiendo estos pasos:

1. Hacer doble clic en la arista. Aparecerá una ventana en la que se pedirá que se introduzca el nuevo peso de la arista.
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Cambiar el peso de una arista (1)
2. Introducir el nuevo peso.
Si se introduce un peso inválido, se mostrará un mensaje de error.
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Cambiar el peso de una arista (2)
Otra forma de cambiar el peso de una arista es la siguiente:

1. Seleccionar la arista (para ello hay que hacer clic en la arista). En la siguiente figura se muestra un grafo en el que se ha seleccionado una de sus aristas:
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Cambiar el peso de una arista (3)
2. Elegir la opción Edit → Change weight.
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Cambiar el peso de una arista (4)
Al elegir dicha opción, aparecerá la ventana de cambio de peso de una arista vista anteriormente.

3. Introducir el nuevo peso.

2.5. Borrar un vértice o una arista

Se puede borrar un vértice o una arista siguiendo estos pasos:

1. Seleccionar el vértice/arista.

2. Pulsar la tecla “Supr”.

o bien siguiendo estos pasos:

1. Seleccionar el vértice/arista.

2. Elegir la opción Edit → Delete.
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Borrar un vértice o una arista (1)
El borrado de un vértice implica el borrado de todas las aristas incidentes con el vértice. En la siguiente figura se muestra un grafo antes y después de borrar uno de sus vértices:
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Borrar un vértice o una arista (2)
3. Establecer pesos para nuevas aristas
A las nuevas aristas se les asignará, por defecto, un peso 1. No obstante, el usuario puede decidir cómo serán los pesos que se asignen automáticamente a nuevas aristas siguiendo estos pasos:

1. Elegir la opción Preferences → Weights for new edges.
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Establecer pesos para nuevas aristas (1)
Al elegir dicha opción, se mostrará una ventana en la que se permitirá introducir los siguientes datos:

· Si se desea crear las aristas con un peso fijo o con un peso aleatorio en un intervalo de pesos.

· El peso fijo (que se ignorará si se decide crear las aristas con un peso aleatorio).

· El peso mínimo y el peso máximo del intervalo de pesos (que se ignorarán si se decide crear las aristas con un peso fijo).
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Establecer pesos para nuevas aristas (2)
2. Introducir los datos en cuestión.

Si se introduce algún peso inválido y el sistema no lo ignora, se mostrará un mensaje de error. En la siguiente figura, por ejemplo, se muestra el mensaje que aparecerá en caso de que se detecte que se ha introducido como peso máximo un peso menor que el peso mínimo:

[image: image20.png](O Create edgeg]
The maximum weight cannot be lesser than the minimum weight

® Create edgeg]





Establecer pesos para nuevas aristas (3)
4. Guardar un grafo
Se puede guardar en un fichero el grafo representado en el área de dibujo siguiendo estos pasos:

1. Elegir la opción File → Save.
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Guardar un grafo (1)

Al elegir dicha opción, se mostrará una ventana como la siguiente:
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Guardar un grafo (2)

2. Especificar el nombre del fichero en el que se desea guardar el grafo, así como el directorio en el que se deberá crear (o en el que se encuentra, si ya existe) el fichero en cuestión.

Si se detecta algún problema al intentar guardar el grafo, se mostrará un mensaje de error.
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Guardar un grafo (3)

5. Cerrar un grafo
Cuando el sistema está funcionando en modo edición, se puede cerrar el grafo representado en el área de dibujo eligiendo la opción File → Close. Al elegir esta opción, el área de dibujo se limpiará.
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Cerrar grafo

6. Abrir un grafo
Cuando el sistema está funcionando en modo edición, se puede abrir un grafo guardado previamente en un fichero siguiendo estos pasos:

1. Elegir la opción File → Open.
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Abrir grafo (1)
Al elegir dicha opción, se mostrará una ventana como la siguiente:
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Abrir grafo (2)
2. Especificar el nombre del fichero en el que está guardado el grafo que se desea abrir, así como el directorio en el que se encuentra el fichero en cuestión.

Si se detecta algún problema al intentar abrir el grafo, se mostrará un mensaje de error.
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Abrir grafo (3)
7. Aplicar un algoritmo a un grafo
7.1. Elegir un algoritmo

Se puede elegir cualquiera de los algoritmos sobre árboles generadores descritos en el capítulo sobre teoría de grafos para aplicarlo al grafo representado en el área de dibujo. Ahora bien, si el sistema detecta algún problema en el grafo (por ejemplo, si el grafo no es conexo, sea cual sea el algoritmo elegido), se muestra un mensaje de error (y no se aplica el algoritmo):
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Elegir un algoritmo (1)

Concretamente, se puede elegir el algoritmo de Prim, Kruskal o Borůvka para construir el árbol generador mínimo eligiendo la opción Algorithms → Minimum spanning tree → Prim Algorithm, Algorithms → Minimum spanning tree → Kruskal Algorithm o Algorithms → Minimum spanning tree → Borüvka Algorithm, respectivamente.
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Elegir un algoritmo (2)

Análogamente, se puede elegir el algoritmo de Prim, Kruskal o Borůvka para construir el árbol generador máximo eligiendo la opción Algorithms → Maximum spanning tree → Prim Algorithm, Algorithms → Maximum spanning tree → Kruskal Algorithm o Algorithms → Maximum spanning tree → Borüvka Algorithm, respectivamente.
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Elegir un algoritmo (3)

La elección de un algoritmo para construir el árbol generador más uniforme hay que realizarla en dos pasos:

1. Elegir la opción Algorithms → Most uniform spanning tree.
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Elegir un algoritmo (4)

Al elegir dicha opción, se mostrará la siguiente ventana:
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Elegir un algoritmo (5)

2. Elegir the maximum weight… si se desea aplicar el algoritmo para construir el árbol más uniforme según la acepción (1) o how close to… si se desea aplicar el algoritmo para construir el árbol más uniforme según la acepción (2).

Análogamente, los pasos para elegir un algoritmo para construir el árbol generador menos uniforme son los siguientes:

1. Elegir la opción Algorithms → Least uniform spanning tree.
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Elegir un algoritmo (6)

Al elegir dicha opción, se mostrará la misma ventana que al elegir la opción Algorithms → Most uniform spanning tree.

2. Elegir the maximum weight… si se desea aplicar el algoritmo para construir el árbol menos uniforme según la acepción (1) o how close to… si se desea aplicar el algoritmo para construir el árbol menos uniforme según la acepción (2).

Finalmente, se puede elegir el algoritmo para construir el camino de capacidad máxima eligiendo la opción Algorithms → Maximum capacity path.
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Elegir un algoritmo (7)

7.2. Dar pasos

Una vez elegido un algoritmo, si el sistema no detecta ningún problema en el grafo representado en el área de dibujo (y, por lo tanto, el sistema pasa a funcionar en modo aplicación de algoritmo), el usuario puede ir intentando dar los pasos del algoritmo elegido. Si el usuario intenta dar un paso y el sistema detecta que el paso es incorrecto, el sistema lo notifica al usuario:
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Dar pasos (1)
El usuario puede intentar dar un paso de dos formas: haciendo clic en un elemento representado en el área de dibujo (un vértice o una arista) o pulsando un botón del panel de opciones.

Los pasos que puede intentar dar el usuario son los siguientes:

· Elegir un vértice, paso disponible para todos los algoritmos. El usuario puede intentar dar este paso haciendo clic en un vértice del grafo.

· Elegir una arista, paso disponible para todos los algoritmos. El usuario puede intentar dar este paso haciendo clic en una arista del grafo.

· Dar por terminada la búsqueda del árbol generador o del camino que se pretende hallar mediante el algoritmo, paso disponible para todos los algoritmos. El usuario puede intentar dar este paso pulsando un botón cuyo texto es:

· “Minimum spanning tree already found”, en el caso de los algoritmos para hallar el árbol generador mínimo.
· “Maximum spanning tree already found”, en el caso de los algoritmos para hallar el árbol generador máximo.
· “Most uniform spanning tree already found”, en el caso de los algoritmos para hallar el árbol generador más uniforme.
· “Least uniform spanning tree already found”, en el caso de los algoritmos para hallar el árbol generador menos uniforme.
· “Maximum capacity path already found”, en el caso del algoritmo para hallar el camino de capacidad máxima.
· Elegir un árbol generador como el más/menos uniforme encontrado hasta el momento, paso disponible para los algoritmos de construcción del árbol generador más uniforme según la acepción (1) y del árbol generador menos uniforme según la acepción (1). El usuario puede intentar dar este paso pulsando un botón cuyo texto es:
· Choose this spanning tree as the most uniform one found so far, en el caso del algoritmo para hallar el árbol generador más uniforme según la acepción (1).
· Choose this spanning tree as the least uniform one found so far, en el caso del algoritmo para hallar el árbol generador menos uniforme según la acepción (1).
· Hallar árbol generador mínimo, paso disponible para el algoritmo de construcción del camino de capacidad máxima. El usuario puede intentar dar este paso pulsando el botón Find minimum spanning tree.
· Hallar árbol generador máximo, paso disponible para el algoritmo de construcción del camino de capacidad máxima. El usuario puede intentar dar este paso pulsando el botón Find maximum spanning tree.
· Hallar árbol generador más uniforme, paso disponible para el algoritmo de construcción del camino de capacidad máxima. El usuario puede intentar dar este paso pulsando el botón Find most uniform spanning tree.
· Hallar árbol generador menos uniforme, paso disponible para el algoritmo de construcción del camino de capacidad máxima. El usuario puede intentar dar este paso pulsando el botón Find least uniform spanning tree.
El usuario también puede pedir al sistema que haga lo siguiente (sea cual sea el algoritmo elegido):

· Dar el siguiente paso del algoritmo, pulsando el botón Solution to next step del panel de opciones.
· Dar todos los pasos restantes del algoritmo, pulsando el botón Solution to remaining steps del panel de opciones.
Recordemos que, además, se puede volver al modo de edición pulsando un botón que siempre estará disponible en el panel de opciones: Back to graph edition.

Por ejemplo, cuando se elige el algoritmo de Prim para hallar el árbol generador mínimo y el sistema no detecta ningún problema en el grafo representado en el área de dibujo, se muestra el panel de opciones con cuatro botones:
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Dar pasos (2)
En este caso, el usuario podrá dar por terminada la búsqueda del árbol generador mínimo (pulsando “Minimum spanning tree already found”), pedir que el sistema dé el siguiente paso (pulsando Solution to next step), pedir que el sistema dé los pasos restantes (pulsando Solution to remaining steps) y volver al modo de edición (pulsando Back to graph edition), además de elegir un elemento (vértice o arista) del grafo representado en el área de dibujo (haciendo clic en el elemento).

7.3. Fin de la aplicación de un algoritmo

Cuando se da el último paso de un algoritmo (tanto si lo da el usuario como si lo da el sistema), el panel de opciones sólo ofrece la opción de volver al modo de edición. El usuario podrá entonces observar la solución encontrada mediante el algoritmo que se ha aplicado antes de volver a la edición del grafo o aplicar otro algoritmo al grafo representado en el área de dibujo.

Además, cuando el usuario da el último paso de un algoritmo, el sistema le felicita por haber hallado el árbol generador o el camino que se pretendía hallar utilizando el algoritmo:
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Fin de la aplicación de un algoritmo

7.4. Información útil para la aplicación del algoritmo

Durante la aplicación de un algoritmo, el sistema irá transmitiendo al usuario, a través del panel de opciones y del área de dibujo, información útil para decidir qué pasos dar a continuación.

Algoritmos de construcción del árbol generador mínimo o máximo
Durante la aplicación de cualquiera de los algoritmos para construir el árbol generador mínimo o máximo, el área de dibujo va indicando qué vértices y/o aristas pertenecen al árbol generador en construcción: los que se muestran en rojo.
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Información útil para la aplicación de un algoritmo (1)

En el caso del algoritmo de Borůvka, los vértices se muestran etiquetados desde el principio de la aplicación del mismo. Este etiquetado se utiliza para ir indicando en el panel de opciones, con una flecha verde, para qué componente conexa puede el usuario elegir una arista. Cada componente conexa se describe:

· en caso de que pertenezca a la misma sólo un vértice, especificando el vértice en cuestión (como en la siguiente figura).
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Información útil para la aplicación de un algoritmo (2)

· en caso contrario, especificando el conjunto de vértices pertenecientes a la componente (como en la siguiente figura).
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Información útil para la aplicación de un algoritmo (3)

Algoritmos de construcción del árbol generador más uniforme o menos uniforme según la acepción (1)
Durante la aplicación del algoritmo para construir el árbol generador más uniforme según la acepción (1) o del algoritmo para construir el árbol generador menos uniforme según la acepción (1), el área de dibujo va indicando qué vértices y/o aristas pertenecen al bosque generador con el que se trabaja: los que se muestran en rojo.

Además, las aristas se muestran etiquetadas desde el principio de la aplicación de uno u otro algoritmo. Este etiquetado se utiliza para ir indicando en el panel de opciones, con una flecha verde, cuál es la siguiente arista a escanear.
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Información útil para la aplicación de un algoritmo (4)

En el panel de opciones, debajo del botón Choose this spanning tree as the most uniform one found so far o Choose this spanning tree as the least uniform one found so far (según el algoritmo que se esté aplicando), se explica que el usuario no debe pulsar el botón en cuestión si piensa que algún árbol generador encontrado previamente es igual de uniforme que el árbol recién encontrado.

Durante la aplicación del algoritmo para construir el árbol generador más uniforme se va indicando, debajo del botón Back to graph edition, cuál es la máxima diferencia de pesos del árbol más uniforme encontrado hasta el momento mientras que, durante la aplicación del algoritmo para construir el árbol generador menos uniforme, se va indicando cuál es la máxima diferencia de pesos del árbol menos uniforme encontrado hasta el momento (también debajo del botón Back to graph edition).

Al terminar de aplicar uno u otro algoritmo, en el área de dibujo se muestra el árbol elegido como el más/menos uniforme (que no necesariamente es el último árbol generador hallado durante la aplicación del algoritmo). Concretamente, se muestran en rojo los vértices y aristas pertenecientes al árbol elegido.

Algoritmos de construcción del árbol generador más uniforme o menos uniforme según la acepción (2)
Durante la aplicación del algoritmo para construir el árbol generador más uniforme según la acepción (2) o del algoritmo para construir el árbol generador menos uniforme según la acepción (2), el área de dibujo va indicando qué vértices y/o aristas pertenecen al árbol generador en construcción: los que se muestran en rojo.

Además, desde el principio de la aplicación de un algoritmo u otro, se muestra en el panel de opciones la media de los pesos de las aristas del grafo (debajo del botón Back to graph edition).
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Información útil para la aplicación de un algoritmo (5)

Algoritmo de construcción del camino de capacidad máxima
Durante la aplicación del algoritmo para construir el camino de capacidad máxima, el área de dibujo va indicando qué vértices y/o aristas pertenecen al camino en construcción: los que se muestran en rojo.

Antes de construir el árbol generador máximo se debe elegir dos vértices (posteriormente, se construirá el camino de capacidad máxima entre los dos vértices elegidos). Cuando se da el paso de construir el árbol generador máximo, el área de dibujo indica qué vértices y aristas pertenecen al árbol construido: los que se muestran en verde más los dos vértices elegidos previamente, en rojo.
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Información útil para la aplicación de un algoritmo (6)

